
Ćwiczenie 
Microsoft SQL Server 2008 – przegląd 

1. Przygotowanie systemu oraz instalacja 

 

1. Na początku należy upewnić się, że system, na którym mamy przeprowadzić instalację SQL 
Server’a, spełnia wymagania danej wersji produktu. Jest to istotne, ponieważ właściwie każda 
wersja, nawet tego samego wydania, różni się pod tym względem. W naszym przypadku 
wykorzystujemy Microsoft SQL Server 2008 r2 (x64) Standard Edition, musimy więc zapewnić, że 
produkt będzie instalowany na 64-bitowym systemie operacyjnym, na komputerze z minimalną 
częstotliwością taktowania zegara 1,4 GHz i 1 GB pamięci RAM. Informacje dotyczące wymagań 
poszczególnych wersji można znaleźć na stronie http://msdn.microsoft.com/en-
us/library/ms143506.aspx. 

2. Gdy upewnimy się, że system spełnia wszystkie wymagania, możemy przystąpić do instalacji. Po 
uruchomieniu instalatora rozpocznie się automatyczne sprawdzanie, czy w systemie 
zainstalowane są wszystkie niezbędne komponenty. Jeśli nie, wyświetlone zostaną dodatkowe 
okna umożliwiające doinstalowanie brakujących komponentów. Następnie wyświetlone zostanie 
główne okno instalatora. 

 

Przejdź do sekcji Installation i wybierz New Installation or add features to an existing 
installation. Rozpoczęty zostanie pierwszy etap, czyli instalacja plików pomocy. 

http://msdn.microsoft.com/en-us/library/ms143506.aspx
http://msdn.microsoft.com/en-us/library/ms143506.aspx


 

3. W pierwszym kroku instalator sprawdza, czy system spełnia wszystkie wymagania, aby można 
bezproblemowo zainstalować pliki pomocy. Można obejrzeć wyniki poszczególnych testów 
klikając na przycisk Show Details >>. 

 

Aby móc kontynuować instalację wszystkie kroki testu muszą zostać pozytywnie zweryfikowane. 
Jeśli przy którejś regule pojawi się status Failed należy usunąć problem i ponownie przeprowadzić 
test. 
Jeśli wszystkie testy przeszły pomyślnie naciśnij przycisk OK. 

  



4. Kolejny krok to weryfikacja klucza produktu lub poinformowanie, że instalowana wersja jest 
darmowa. Wybierz opcję zgodną z instalowanym produktem. 

 

5. Następnie zapoznaj się z licencją i jeśli ją akceptujesz wybierz opcję I accept the license terms 
i naciśnij przycisk Next >. 

 

  



6. W ostatnim kroku pojawi się informacja o instalowanych w tym etapie elementach. W tym 
przypadku będą to jedynie pliki pomocy. Naciśnij Install, aby je zainstalować. 

 

7. Po pomyślnym zakończeniu instalacji plików pomocy rozpocznie się etap właściwej instalacji 
produktu. Pierwszym krokiem jest sprawdzenie, czy system spełnia konieczne wymagania aby w 
ogóle móc przeprowadzić instalację. Aby móc przejść dalej wszystkie testy muszą zostać 
pozytywnie zweryfikowane. Przejdź do następnego kroku. 

 

  



8. W kolejnym kroku instalator pyta, czy zainstalować wszystkie funkcje produktu, czy pozwolić 
użytkownikowi zadecydować, które mają zostać zainstalowane. Wybierz opcję SQL Server 
Feature Instalation, która pozwoli na manualny dobór funkcji, a następnie przejdź dalej. 

 

9. W kolejnym kroku należy wybrać cechy SQL Server’a, które mają zostać zainstalowane. W naszym 
przypadku chodzi nam jedynie o silnik bazy danych oraz narzędzia do zarządzania. Dodatkowo 
zainstalujemy materiały edukacyjne związane z produktem (SQL Server Books Online). 

 

  



10. Kolejny krok jest ponownym testem, który system musi przejść, aby produkt mógł zostać 
zainstalowany. 

 

11. W następnym kroku definiowane są parametry instancji, takie jak nazwa oraz ścieżka. Jeśli jest to 
pierwsza instalacja należy wybrać wówczas wybrać opcję instalacji instancji domyślnej (Default 
instance). Jeśli w systemie był już zainstalowany SQL Server i chcemy doinstalować kolejną 
instancję, wybierz opcję Named instance i nadaj jej nazwę. 

 

  



12. Następnie instalator sprawdzi, czy na dysku znajduje się wystarczająca ilość miejsca, aby móc 
przeprowadzić proces instalacji wybranych funkcji produktu. Jeśli nie, należy zwolnić więcej 
miejsca na dysku lub powrócić do kroku Feature Selection, aby zmniejszyć rozmiar instalacji 
kosztem niektórych funkcji. 

 

13. W kolejnym kroku należy wskazać konta, które będą wykorzystywane przez poszczególne usługi 
produktu. W naszym przypadku instalowane są trzy usługi: 

 SQL Server Agent – odpowiedzialna za automatyczne wykonywanie zaplanowanych zadań, 

 SQL Server Database Engine – główna usługa, mająca za zadanie przetwarzanie 
i zabezpieczanie danych, 

 SQL Server Browser – proces nasłuchujący na nadchodzące zgłoszenia do SQL Server’a. 
Zaleca się, aby dla każdej usługi stworzyć osobne konto użytkownika w systemie Windows. 
Instalator automatycznie przyzna użytkownikom wymagane uprawnienia do poprawnego 
funkcjonowania danej usługi. Stwórz po jednym koncie nieadministracyjnym zabezpieczonym 
hasłem dla każdej instalowanej usługi (np. SSAgent oraz SSBDEngine), następnie kliknij rozwijane 
pole wyboru obok każdej z usług i wybierając <<Browse...>> przypisz odpowiednio utworzone 
konta wpisując w polu Password hasło do danego konta. 
W tym kroku można również zdefiniować sposób uruchamiania każdej z usług (Startup Type). 
Możliwe jest uruchamianie automatyczne (Automatic), ręczne (Manual) lub zaznaczenie, że 
usługa w ogóle nie ma być uruchamiana (Disabled). W naszym przypadku pozostaw dla 
wszystkich usług domyślne sposoby uruchamiania i przejdź do kolejnego kroku. 



 

14. Kolejny krok pozwala na wybór sposobu uwierzytelniania użytkowników. Można wybrać 
uwierzytelnianie przez system operacyjny (Windows authentication mode) lub uwierzytelniania 
zarówno przez system operacyjny jak i poprzez konta utworzone w SQL Serverze. 
Dodatkowo należy w tym kroku wybrać administratorów systemu. W celu wybrania aktualnie 
zalogowanego do systemu Windows  użytkownika wybierz Add Current User. 
Zakładka Data Directories pozwala zdefiniować ścieżki, pod którymi mają być zapisywane pliki z 
danymi. Pozostaw pozostałe wartości domyślne i przejdź do kolejnego kroku. 

 



15. W kolejnym kroku instalator pyta, czy ma informować firmę Microsoft o ewentualnych błędach 
występujących podczas działania produktu. W naszym przypadku nie będziemy chcieli takich 
informacji wysyłać. 

 

16. Kolejny krok wykonuje już ostatni test poszczególnych komponentów systemu. 

 

  



17. Ostatni krok przed instalacją wyświetla podsumowanie wybranych opcji. Przejrzyj dokładnie 
raport i upewnij się, że wszystkie parametry są zgodne z twoimi wymaganiami, a następnie kliknij 
przycisk Install, aby rozpocząć instalację produktu. 

 

18. W trakcie instalacji okno będzie prezentowało informacje o aktualnie wykonywanym etapie oraz 
ogólnym postępie. 

 

  



19. Po zakończonej instalacji produktu wyświetlona zostanie ścieżka do pliku logu, zawierającego 
szczegółowe informacje o przebiegu instalacji. 

 

  



2. Obiekty systemowe 

 

Czas trwania: 10 minut 

 

Jest kilka sposobów zarządzania SZBD SQL Server. Najbardziej elastycznym i oferującym największe 
możliwości konfiguracji jest linia poleceń. Drugą możliwością jest narzędzie SQL Server Management 
Studio, które pozwala w wygodny sposób zarządzać wszystkimi instancjami. W poniższych 
ćwiczeniach będziemy wykorzystywali właśnie to narzędzie. 

1. Uruchom maszynę wirtualną i zaloguj się na konto Admin, a następnie uruchom program SQL 
Server Management Studio (dostępny bezpośrednio z menu Start). Pojawi się okno połączenia 
do serwera. W polu Server type można wybrać rodzaj serwera, z którego chcemy korzystać, pole 
Server name pozwala wprowadzić nazwę instancji serwera, do której chcemy się podłączyć, 
natomiast pole Authentication pozwala wybrać sposób uwierzytelniania. Pozostaw wszystkie 
wartości domyślne i naciśnij Connect. 

 

2. Po lewej, w eksploratorze obiektów (Object Explorer) jako główny węzeł widzisz instancję, do 
której właśnie się podłączyłeś/aś. Możesz jednak podłączyć się do większej liczby instancji. Mogą 
to być serwery zarówno zdalne jak i lokalne. W tym celu należy w eksploratorze rozwinąć menu 

Connect i wybrać typ serwera, do którego chcemy się połączyć, lub kliknąć na ikonkę . My 
jednak będziemy pracowali tylko na jednej instancji. Rozwiń teraz katalog Databases znajdujący 
się pod węzłem reprezentującym instancję bazy danych. Zauważysz tam dwa katalogi: 

 System Databases – przechowujący systemowe bazy danych, 

 Database Snapshots – kopie baz danych (tylko do odczytu). 

Wszystkie bazy danych użytkowników (których na razie nie ma w naszej szkoleniowej instancji) 
przechowywane są bezpośrednio w katalogu Databases. 

Rozwiń folder System Databases. 

 



Wewnątrz katalogu znajdują się cztery systemowe bazy danych: 

 master – zawiera informacje o wszystkich bazach danych użytkowników; może być tylko 
jedna na całą instancję; powinna być regularnie „backup’owana”; 

 model – szablon do tworzenia nowych baz danych użytkowników; wszystkie zmiany 
wprowadzone w tej bazie znajdą się w każdej nowo tworzonej bazie danych; 

 msdb – przechowuje informacje o wszystkich zadaniach ustawionych w harmonogramie 
zadań instacji, automatycznych akcjach, zaplanowanych kopiach zapasowych, konfiguracji 
usługi Mail pozwalającej wysyłać wiadomości email z bazy danych; 

 tempdb – wykorzystywana podczas przenoszenia danych, dokonywania porządków; 
czyszczona przy każdym restarcie instancji. 
 

3. Zarządzając instancją, konieczność odwoływania się do systemowych baz danych przez 
administratora może występować niezwykle rzadko. Dlatego też, aby przez przypadek nie 
dokonać zmiany w którejś tych baz, zamiast w bazie użytkownika, wygodnym rozwiązaniem jest 
ukrycie obiektów systemowych w eksploratorze. W tym celu z głównego menu programu wybierz 
Tools -> Options. 

 

Następnie, w zakładce General zaznacz pole Hide system objects in Object Explorer i naciśnij 
przycisk OK. 

 

Zostanie wyświetlona informacja o konieczności ponownego uruchomienia środowiska, aby 
zmiany zostały wprowadzone. Naciśnij przycisk OK, zamknij środowisko i uruchom ponownie, 
podłączając się do tej samej instancji. 

Rozwiń folder Databases i zobaczysz, że nie ma w nim katalogu systemowych baz danych. 
Pamiętaj jednak, że one nie zostały usunięte, a jedynie schowane! 

  



3. Tworzenie bazy danych 

 

Czas trwania: 30 minut 

 

W tym ćwiczeniu utworzymy bazę danych na dwa sposoby. Pierwszy sposób to zbudowanie bazy od 
podstaw. Natomiast w drugim przypadku stworzymy bazę na podstawie istniejącego pliku. 

1. Kliknij prawym przyciskiem myszy (PPM) na katalogu Databases w eksploratorze obiektów 
i wybierz opcję New Database…. W oknie, które się pojawi, wpisz w polu Database name nazwę 
bazy danych – Baza1. 

 

Zauważ, że narzędzie automatycznie nadaje nazwy plikom – dla pliku danych oraz pliku logu. 
Zwróć również szczególną uwagę na kolumny Initial Size oraz Autogrowth. Pierwsza z nich 
zawiera informację o początkowym rozmiarze obu plików. Druga natomiast o rozmiarze, o który 
plik ma być rozszerzany w przypadku, gdy zabraknie w nim miejsca. Wartości te są bardzo istotne, 
a w szczególności pole Autogrowth, ponieważ rozszerzanie rozmiaru każdego z plików powoduje 
blokowanie całej bazy danych. Dlatego też przyjęcie zbyt małej wartości przy dużej liczbie nowych 
danych w bazie będzie powodowało jej częstą niedostępność. Z drugiej strony przyjęcie zbyt 
dużej wartości będzie powodowało niepotrzebne zajmowanie miejsca na dysku. W naszym 
przykładzie plik danych będzie rozszerzał się co 1 MB, a plik logu co 10 %. Dodatkowo, można 
narzucić maksymalny rozmiar, jaki mogą przyjąć pliki. Gdy zostanie on osiągnięty, korzystanie 
z bazy danych stanie się niemożliwe. Gdy ustawimy tę wartość na nieograniczoną, wówczas baza 
będzie niedostępna dopiero gdy skończy się miejsce na dysku. Należy wówczas zwiększyć ilość 
miejsca na dysku, aby ponownie umożliwić korzystanie z bazy. 

2. Przejdź teraz do zakładki Options i przyjrzyj się domyślnym wartościom niektórych z opcji. Zwróć 
szczególną uwagę na pole wyboru Recovery model. Pozwala ono wybrać trzy modele 
odzyskiwania bazy danych: 

 Simple – umożliwia administratorowi odtworzenie bazy jedynie z ostatniego pełnego lub 
różnicowego backup’u. Wszystkie dane od tego czasu zostają utracone. 



 Full – daje administratorowi największą elastyczność w odtwarzaniu. Umożliwia wybranie 
momentu w przeszłości, z którego baza ma zostać odtworzona. Wykorzystuje do odtwarzania 
również plik logu. 

 Bulk-logged – zalecana jedynie podczas wykonywania dużych operacji wsadowych na bazie 
danych. 

 

Zwróć jeszcze uwagę na pole Collation. Rozwiń listę wartości. Czy wiesz/domyślasz się do czego 
służy opcja collation. Spróbuj odszukać informacje o tej opcji w Internecie. Gdy skończysz 
przeglądać dostępne opcje, pozostaw wszystkie wartości domyślne i kliknij przycisk OK. 
 

3. W eksploratorze obiektów, w katalogu Databases powinna pojawić się utworzona baza. Rozwiń 
katalog nowej bazy, kliknij PPM na folderze Tables i wybierz New Table…. Pojawi się obszar 
umożliwiający zdefiniowanie kolumn tabeli. 

 



Nadaj pierwszej kolumnie nazwę Id i jako typ danych wybierz numeric(18,0) i odznacz opcję 
Allow Nulls. Następnie w zakładce Column Properties rozwiń sekcję Identity Specification, ustaw 
parametry (Is Identity) na Yes a Identity Increment oraz Seed na 1. W ten sposób utworzyliśmy 
identyfikator, który dla każdego nowego wiersza będzie przybierał wartość o 1 większą, 
rozpoczynając od wartości 1. W SZBD Oracle wykorzystywaliśmy do tego celu sekwencje oraz 
triggery. 

 

Zdefiniowanie kolumny jako identyfikator nie powoduje jednak ustawienia jej jako klucza 
głównego relacji. Aby to zrobić kliknij PPM na utworzonej kolumnie i z podręcznego menu 
wybierz Set Primary Key. 

4. Stwórz teraz kolejne kolumny tabeli: 

 Nazwa – varchar(50), not null 

 DataUtworzenia – date, 

 T_Id – numeric(18,0), not null 

 

5. Przejdź teraz do sekcji Properties (menu rozwijane po prawej) i w polu (Name) wpisz nazwę 
tabeli – Produkty. W polu Description możesz podać opis dla tabeli, natomiast pole Schema 
pozwala wybrać schemat, w którym tabela ma zostać zapisana. Na razie pozostawimy tabelę w 
domyślnym schemacie (dbo). Zapisz tabelę wybierając File -> Save Produkty lub wykorzystując 
skrót Ctrl + S. Rozwiń katalog Tables w bazie Baza1 aby zobaczyć utworzoną tabelę. 

6. W analogiczny sposób dodaj tabelę TypyProduktow o schemacie: 

 Id – numeric(18,0), not null, Identity, Primary Key 

 Nazwa – varchar(50), not null 

 

7. Przejdź z powrotem do definicji tabeli Produkty. Utworzymy teraz na kolumnie T_Id klucz obcy 
do tabeli TypyProduktow. Kliknij PPM na kolumnie T_Id i podręcznego menu wybierz 



Relationships.... W oknie, które się pojawi naciśnij przycisk Add aby dodać nową zależność, 
a następnie przejdź do pola Tables And Columns Specification i kliknij na przycisk 
z wielokropkiem. 

 

Pojawi się okno służące do wyboru tabel oraz kolumn, które mają wchodzić w skład związku. 
W polu Primery key table wybierz tabelę ProduktyTable i kolumnę Id. Dla tabeli Produkty 
wybierz natomiast T_Id. 

 

Zapisz utworzone powiązanie klikając OK i następnie Close. Zapisz teraz wprowadzone zmiany. 
Wyświetlone zostanie ostrzeżenie, że zmianie ulega nie tylko tabela Produkty ale również 
TypyProduktow. Potwierdź chęć zapisania wybierając Yes. 

 

8. Rozwiń teraz katalog Database Diagrams. Pojawi się informacja, że baza nie posiada 
odpowiednich obiektów, aby utworzyć diagram i zostaniemy zapytani czy mają one zostać 
utworzone. Wybierz Yes. 



 

Jak widzisz baza nie posiada żadnych diagramów. Kliknij więc PPM na katalogu i wybierz New 
Database Diagram. Pojawi się okno, które pozwala wybrać tabele, które mają zostać włączone do 
diagramu. Wybierz obie (Shift) i kliknij Add lub kliknij Add dla każdej osobno. 

 

Twój diagram powinien wyglądać mniej więcej tak jak poniżej. 

 

Zapisz diagram, nazywając go po prostu Diagram. 

9. Dodamy teraz do tabel dane. W tym celu kliknij PPM na tabeli TypyProduktow, wybierz Edit Top 
200 Rows i wprowadź kilka typów produktów (np. Stół, Krzesło, Szafa). Zauważ, że nie musisz 
podawać identyfikatorów – zostaną one wypełnione automatycznie. 

 

W analogiczny sposób wprowadź kilka wierszy w tabeli Produkty. Pamiętaj, że pole T_Id jest 
kluczem obcym, może więc jedynie przyjmować wartość znajdujące się w tabeli TypyProduktow. 
Aby to zweryfikować spróbuj dodać produkt niezdefiniowanego typu. 

 

10. Teraz utworzymy nową bazę danych wykorzystując istniejący plik. W tym celu kliknij PPM na 
katalogu Databases i wybierz Attach…. W oknie, które się pojawi kliknij przycisk Add… i wskaż 
lokalizację pliku Instytut.mdf, który znajduje się na dysku C w katalogu DB. 



 

W dolnej części okna pojawią się dwa wpisy o plikach tworzonej bazy: pliku danych oraz pliku 
logu. Ponieważ załączamy tylko plik z danymi usuń plik logu zaznaczając go i klikając przycisk 
Remove. Zatwierdź proces przyciskiem OK. 

11. Zmienimy teraz nazwę utworzonej bazy. W tym celu kliknij PPM na bazie w eksploratorze 
obiektów, wybierz Rename i nazwij bazę Instytut. Możesz również podejrzeć dane zawarte 
w poszczególnych tabelach. W tym celu kliknij PPM na każdej z nich i wybierz Select Top 1000 
Rows. 

  



4. Struktury fizyczne 

 

Czas trwania: 10 minut 

 

W tym ćwiczeniu przyjrzymy się plikom bazy danych. Omówimy po krótce ich typy, rozmieszczenie 
oraz sposoby ich przemieszczania. 

1. Rozwiń katalog Databases w eksploratorze obiektów, kliknij PPM na bazie Baza1 i wybierz 
Properties, a następnie przejdź do zakładki Files. Znajdują się tutaj informacje o plikach, z których 
korzysta dana baza. W naszym przypadku są to dwa typy plików – plik logu (*.ldf) oraz plik 
danych (*.mdf). Możliwe jest również dodanie dodatkowych plików danych, które będą miały 
rozszerzenie (*.ndf). Wykorzystując przesuwak przejdź do kolumny Path aby odczytać lokalizację 
plików. 

 

2. Bardzo ogólna zasada rozmieszczania plików bazy danych jest taka, aby umieszczać fragmenty, 
które są często wykorzystywane współbieżnie, na osobnych fizycznych dyskach. Za przykład mogą 
posłużyć pliki danych oraz plik logu. W rzeczywistym wykorzystaniu dane są równolegle 
odczytywane z plików danych i zapisywane do logu. Rozmieszczenie tych plików na osobnych 
dyskach może zapewnić znaczny wzrost efektywności działania bazy. 

3. Aby zilustrować proces przenoszenia plików, przeniesiemy teraz pliki danych oraz logu do 
osobnych lokalizacji. Zanotuj lokalizację plików bazy Baza1 a następnie zamknij okno właściwości 
bazy. Następnie w eksploratorze obiektów kliknij PPM na bazie Baza1 i wybierz Tasks -> 
Detach…. Kliknij przycisk OK w oknie, które się pojawi, a następnie odśwież katalog Databases 
(F5 lub PPM -> Refresh) – Baza1 zniknie z katalogu. Nie oznacza to jednak, że została ona 
usunięta. Oznacza to jedynie, iż została odłączona i korzystanie z niej jest niemożliwe. Przejdź 
teraz do folderu na dysku zawierającego pliki danych oraz logu i przenieś je odpowiednio do 
lokalizacji C:\Disk1 oraz C:\Disk2. 



 

Powróć do narzędzia SQL Server Management Studio, kliknij PPM na katalogu Databases 
w eksploratorze obiektów i wybierz Attach…. Pojawi się okno dołączania bazy danych. Kliknij 
Add… i wskaż lokalizację pliku danych bazy Baza1. 

 

Spowoduje to dołączenie pliku danych. Zauważ jednak, że plik logu pozostał nieodnaleziony (Not 
Found w polu Message). Aby rozwiązać problem i dołączyć plik logu kliknij na przycisku 
z wielokropkiem znajdującym się obok niepoprawnej ścieżki, a następnie wskaż poprawną 
lokalizację pliku logu (C:\Disk2\Baza1_log.ldf). 



 

Zakończ proces klikając przycisk OK a następnie odświeżając katalog Databases. Baza powinna 
być znów widoczna. 

  



5. Użytkownicy i schematy 

 

Czas trwania: 25 minut 

 

W tym ćwiczeniu dodamy nowego użytkownika do systemu i nadamy mu uprawnienia systemowe 
oraz obiektowe. Przybliżymy również sposoby uwierzytelniania, a także pokażemy różnice dotyczące 
schematów w stosunku do SZBD Oracle. 

1. W eksploratorze obiektów rozwiń katalog Security a następnie Logins. Zauważ, że znajdują się 
tutaj konta, które definiowałeś podczas instalacji dla każdej z usług. Kliknij PPM na folderze 
Logins i wybierz New Login…. Pojawi się okno tworzenia nowego użytkownika. 

 

2. SQL Server umożliwia dwa rodzaje uwierzytelniania: 

 poprzez system operacyjny Windows, 

 przez SZBD SQL Server. 

Można więc dodać użytkownika systemu operacyjnego – zarówno lokalnego jak i domenowego. 
Aby to zrobić kliknij na przycisk Search obok pola Login name. Pojawi się okno wyboru 
użytkowników. 

 



Klikając na przycisk Locations… możemy przeglądać komputery, sieci lub grupy robocze, z których 
chcemy dodać konta. 

 

Przycisk Advanced pozwala na zaawansowane wyszukania kont we wskazanej lokalizacji. Naciśnij 
ten przycisk, a następni kliknij Find Now. 

 

Nie wybieraj żadnego z istniejących użytkowników tylko zamknij okno wyboru, gdyż będziemy 
definiowali nowego użytkownika. 

3. Podaj swoje imię jako nazwę użytkownika w polu Login name. Następnie zmień sposób 
uwierzytelniania na SQL Server Authentication. Spowoduje to odblokowanie kilku opcji konta. 
W polu Password wprowadź hasło, którym chcesz się uwierzytelniać i powtórz je w polu Confirm 
password. Opcja Enforce password policy pozwala włączyć zasady bezpieczeństwa dotyczące 
haseł, takie jak wymuszanie cyklicznej zmiany hasła. Odznacz tę opcję dla swojego konta i przejdź 
do zakładki Server Roles. Pozwala ona wybrać role, które mają zostać przypisane użytkownikowi. 
Zakres działania tych ról obejmuje całą instancję. 



 

Przejdź do zakładki User Mapping. Umożliwia ona przypisanie użytkownikowi predefiniowanych 
ról dla konkretnych baz danych. 

 

Niczego nie zmieniając kliknij przycisk OK. Spowoduje to dodanie nowego użytkownika do 
katalogu Logins. 

4. Spróbujemy teraz połączyć się do instancji wykorzystując utworzonego użytkownika. Kliknij PPM 
na węźle instancji w eksploratorze obiektów (korzeń drzewa katalogów) i wybierz Disconnect. 
Teraz kliknij przycisk Connect i wybierz Database Engine… lub skorzystaj z przycisku skrótu. W 



polu Authentication wybierz opcję SQL Server Authentication, następnie podaj nazwę swojego 
użytkownika oraz jego hasło i kliknij Connect. 

 

Na ekranie pojawi się komunikat informujący o niepowodzeniu logowania na dane konto wraz 
z numerem błędu. 

 

Przyczyną tego błędu jest konfiguracja instancji. Instalując SQL Server wybieraliśmy w jednym 
z kroków (Ćw. 1, pkt. 14) dopuszczalne sposoby uwierzytelniania użytkowników i wybraliśmy 
jedynie uwierzytelnianie systemem operacyjnym. Musimy więc zmienić ten parametr, aby 
dopuścić możliwość logowania użytkowników spoza systemu operacyjnego. 

5. W polu Authentication wybierz ponownie opcję Windows Authentication i kliknij Connect. 
Następnie kliknij PPM na węźle instancji w eksploratorze obiektów, wybierz Properties i przejdź 
do zakładki Security. Zmień sposób uwierzytelniania na mieszany i zatwierdź przyciskiem OK.  

 



Pojawi się informacja mówiąca o tym, że aby zmiany zostały wprowadzone należy najpierw 
zrestartować serwer. 

 

Kliknij PPM na węźle instancji i wybierz Restart. Pojawi się okno z prośbą o potwierdzenie. 
Naciśnij Yes. 

6. Po ponownym uruchomieniu instancji, rozłącz się i spróbuj zalogować się na swoje konto. 
7. Przeloguj się z powrotem na konto administratora. Kliknij PPM na bazie Instytut, wybierz 

Properties, przejdź do zakładki Files i w polu Owner, wykorzystując wyszukiwarkę (…), podaj 
swojego użytkownika jako właściciela. 

 

Potwierdź wybór klikając OK. 

8. Ponownie zaloguj się do instancji wykorzystując dane uwierzytelniające swojego użytkownika 
i wygeneruj diagram dla bazy Instytut. Powinien on wyglądać w następujący sposób: 

 

9. W SZBD Oracle z użytkownikiem nierozerwalnie powiązany jest schemat o takiej samej nazwie. 
Zobaczmy jak to zagadnienie rozwiązuje SQL Server. Zaloguj się ponownie na konto 
administracyjne, przejdź do bazy Instytut, kliknij PPM i rozwiń folder Tables. Jak widzisz wszystkie 
tabele należą do schematu dbo. Jest to domyślny schemat, w którym tworzone są wszystkie 
obiekty, dla których schemat nie został podany explicite. Spróbujemy teraz zmienić schemat 
tabeli ETATY na naszego użytkownika. Kliknij PPM na tabeli dbo.Etaty, wybierz Design a 



następnie przejdź do sekcji właściwości (Properties). Gdy rozwiniesz pole Schema zauważysz, że 
nie ma schematu Twojego użytkownika. 

 

Jest tak dlatego, ponieważ w SQL Server schematy należy postrzegać raczej jako przestrzenie 
nazw. Nie są więc one nierozerwalnie powiązane z użytkownikiem. Obiekty można więc 
swobodnie przemieszczać pomiędzy schematami, nie należy jednak traktować tego jako 
przekazywania ich pomiędzy użytkownikami. 

10. Wyszukaj informację, jak dodaje się nowe schematy w SQL Server Management Studio i spróbuj 
dodać nowy schemat o nazwie produkty do bazy Baza1. Spróbuj przypisać tabele Produkty i 
TypyProduktow do schametu produkty. 

  



6. Tworzenie aplikacji bazodanowej 

 

Czas trwania: 60 minut 

 

W tym ćwiczeniu wygenerujemy aplikację opartą o bazę danych Instytut, wykorzystując technologię 
Visual Studio Lightswitch. Aby zasymulować sytuację, w której aplikacja znajduje się na innym 
komputerze niż serwer bazy danych, aplikację będziemy wywoływali z maszyny lokalnej. 

1. Skoro mamy odwoływać się do naszej bazy ze zdalnej maszyny musimy najpierw odpowiednio 
skonfigurować zarówno instancję jak i sam serwer. Pierwszym krokiem będzie zezwolenie na 
zdalne połączenia do instancji. Kliknij PPM na węźle instancji w eksploratorze obiektów, wybierz 
Properties i przejdź do zakładki Connections. Znajduje się tutaj szereg opcji, pozwalających 
dostosować dostęp zdalny do instancji. Pole Maximum numer of concurrent connections 
pozwala na przykład ograniczyć liczbę otwartych połączeń zdalnych. Z naszego punktu widzenia 
najważniejszym polem jest Allow remote connections to this server, które włącza lub wyłącza 
połączenia zdalne. Upewnij się, że opcja ta jest włączona i kliknij OK. 

 

2. Kolejnym krokiem jest uruchomienie usługi SQL Server Browser. Nasłuchuje ona na zgłoszenia 
przychodzące do serwera i udostępnia informacje o znajdujących się na nim instancjach. Aby ją 
uruchomić musimy dostać się do katalogu usług systemowych. W tym celu wybierz Start, Run…, 
a następnie w polu tekstowym wpisz services.msc. 

 



Alternatywnie, możesz dostać się do tego zasobu otwierając Control Panel -> Administrative 
Tools -> Services. 

 

Przejdź do wpisu dotyczącego usługi SQL Server Browser. Zobaczysz, że kolumna statusu usługi 
(Status) jest pusta, co oznacza że usługa nie jest uruchomiona. Dodatkowo kolumna Startup Type 
informuje o sposobie uruchamiania (Disabled oznacza, iż usługa jest wyłączona, czyli korzystanie 
z niej jest niemożliwe). Kliknij PPM na wpisie usługi i wybierz Properties. Ustawimy automatyczne 
włączanie usługi przy starcie systemu Windows. W tym celu z pola Startup type wybierz 
Automatic i kliknij Apply. Teraz możliwe jest uruchomienie usługi. Aby to zrobić kliknij przycisk 
Start, a następnie zamknij okno właściwości usługi klikając OK. 

 

3. Kolejnym krokiem jest dodanie odpowiednich wyjątków do zapory systemowej. Kliknij Start -> 
Control Panel -> Windows Firewall i przejdź do zakładki Exceptions. Następnie kliknij Add Port…. 
SQL Server domyślnie wykorzystuje port numer 1433. Wpisz w polu Name nazwę, jaką chcesz 
nadać dla wpisu, na przykład SQL Server, a w polu Port number podaj numer 1433. Wybierz 
protokół TCP i zatwierdź przyciskiem OK. 



 

Na liście wyjątków powinien pojawić się Twój wpis. 

 

4. Ostatnim krokiem konfiguracyjnym po stronie serwera jest faktyczne udostępnienie portów. 
Uruchom narzędzie SQL Server Configuration Manager. Następnie przejdź do sekcji SQL Server 
Network Configuration -> Protocols for MSSQLSERVER. 

 

Kliknij PPM Na protokole TCP/IP i wybierz Properties. Upewnij się, że pole Enabled w zakładce 
Protocol ustawione jest na wartość Yes. Następnie przejdź do zakładki IP Address i w sekcjach 
IP1 oraz IP2 również ustaw pole Enabled na Yes. 



 

Upewnij się również, że adres IP podany w sekcji IP1 jest poprawnym adresem tego serwera 
(w tym przypadku – maszyny wirtualnej). Aby to sprawdzić uruchom konsolę systemu Windows 
i wpisz polecenie ipconfig. 

 

Zatwierdź zmiany wprowadzone w konfiguracji TCP/IP przyciskiem OK, następnie przejdź do 
sekcji SQL Server Services, kliknij PPM na usłudze SQL Server i wybierz Restart. 

 

5. Skoro już serwer został skonfigurowany możemy zabrać się za tworzenie aplikacji. W tym celu 
posłużymy się technologią Visual Studio LightSwitch, która pozwala wygenerować aplikację 
bazodanową bez pisania kodu. 

Z menu Start->All Programs, uruchom Visual Studio LightSwitch 2011. Z menu File wybierz New 
Project…. Z lewej części okna, w sekcji Installed Templates wybierz LightSwitch, a następnie 
LightSwitch Application (Visual C#). W polu Name podaj nazwę dla swojej aplikacji, w polu 
Location wprowadź natomiast katalog, w którym chcesz ją zapisać i zatwierdź przyciskiem OK. 



 

6. Pojawi się strona startowa kreatora aplikacji. Opcja Create new table umożliwia rozpoczęcie 
budowania nowych tabel na potrzeby aplikacji. My jednak posłużymy się istniejącą bazą danych 
Instytut, znajdującą się na naszej maszynie wirtualnej. Wybierz Attach to external Data Source. 

 

Pojawi się okno wyboru źródła danych. Wybierz opcję Database i kliknij Next >. 



 

W kolejnym oknie należy sprecyzować od jakiego dostawcy będziemy pobierali dane. Upewnjj się 
że w polu Data source wybrane są opcje Microsoft SQL Server jako źródło i .NET Framework 
Data Provider for SQL Server jako dostawca danych. 

 

W oknie definiowania parametrów połączenia z bazą danych, w polu Server name podaj nazwę 
maszyny wirtualnej, czyli SPBD. Następnie możesz wybrać sposób uwierzytelniania do serwera. 
Wybierz uwierzytelnianie przez SQL Server i podaj nazwę oraz hasło swojego użytkownika, 
którego zdefiniowałeś w ćwiczeniu 5. Możesz również zaznaczyć, aby program zapamiętał twoje 
hasło. Następnie w polu Select or enter database name wybierz bazę Instytut i zatwierdź 
przyciskiem OK. 



 

W kolejnym kroku program zapyta o tabele, z których chcesz korzystać tworząc aplikację. Wybierz 
tabele ETATY, PRACOWNICY oraz ZESPOLY i kliknij Finish. 

 

Po prawej, w eksploratorze solucji (Solution Explorer) pojawi się pod folderem Data Sources 
węzeł InstytutData zawierający dodane tabele. Zapisz cały projekt przy pomocy skrótu Ctrl + Shift 
+ S lub wybierająć File -> Save All. 

7. Nasza aplikacja ma zdefiniowaną warstwę dostępu do danych. Teraz dodamy do niej widoki. 
Kliknij PPM na katalogu Screens i wybierz Add Screen. Pojawi się okno konfiguracji widoków. 
Wybierz wzorzec List and Details Screen, a jako dane do widoku (Screen Data) wybierz tabelę 
ZESPOLY. Zaznacz również, że jako dodatkowe dane mają zostać załączone informacje z tabeli 
PRACOWNICY. W ten sposób dla każdego zespołu wyświetlani będą również jego pracownicy. 
Zakończ proces klikając OK. 



 

8. Dodaj teraz w analogiczny sposób widok dla tabeli ETATY jako listę ze szczegółami oraz widok dla 
tabeli PRACOWNICY jako listę wyszukiwaną (Search Data Screen). 

9. Chcemy najpierw przetestować opcję, w której nasz program jest aplikacją internetową, dlatego 
otwórz właściwości projektu (Properties), a następnie w zakładce Application Type wybierz Web 
i zapisz projekt. 

 

10. W zależności od używanej wersji technologii LightSwitch, aby móc korzystać z utworzonej 
aplikacji może zaistnieć potrzeba modyfikacji domyślnych opcji internetowych. W ramach 
wykorzystywanej maszyny wirtualnej nie powinno to być konieczne, ale w innych środowiskach 
do celów testowych jeśli aplikacja nie zadziała, uruchom Panel sterowania, przejdź do sekcji Sieć 
i Internet i wybierz Opcje internetowe. Przejdź do zakładki Zabezpieczenia, wybierz Lokalny 
intranet i kliknij Witryny. Odznacz pole wyboru Automatycznie wykryj sieć intranet i zaznacz 
wszystkie pozostałe. Potwierdź przyciskiem OK. 

 



11. Wróć do narzędzia Visual Studio i wybierz Build -> Build Instytut. Następnie w menu Debug 
kliknij Start Without Debugging lub użyj skrótu Ctrl+ F5 aby uruchomić aplikację. Przetestuj jej 
działanie. Sprawdź czy jak zmienisz i zapiszesz dane to zmienią się one w bazie. 

12. Spróbuj odnaleźć w projekcie miejsce gdzie można zmienić nazwy widoków i nagłówków. Spróbuj 
zmienić nazwę widoku Search PRACOWNICies na Pracownicy. Uruchom ponownie aplikację i 
sprawdź swoje zmiany. 

13. Teraz przygotujemy aplikację instalacyjną na naszą maszynę lokalną. Po pierwsze – chcemy aby 
była to aplikacja desktopotwa. Przejdź ponownie do właściwości projektu i w sekcji Application 
Type w polu Client zaznacz opcję Desktop, a w sekcji Application Server zaznacz pierwsze pole 
wyboru. 

 

Kliknij na przycisk Publish. 

14. Po uruchomieniu kreatora tworzenia aplikacji, w pierwszym kroku pozostaw zaznaczoną opcję 
Desktop i przejdź dalej klikając Next >. 

 

15. W drugim kroku możesz wybrać sposób instalacji aplikacji. Pozostaw zaznaczoną opcję Local, czyli 
zainstalowanie na maszynie lokalnej użytkownika. Przejdź dalej. 



 

16. W kolejnym kroku podaj ścieżkę do katalogu, w którym chcesz umieścić pliki instalacyjne. Stwórz 
na pulpicie katalog Instytut. Wskaż ten katalog jako docelowy i przejdź dalej. 

 

17. W kolejnym kroku możesz wybrać w jakie dodatkowe komponenty mają zostać zainstalowane 
oraz skąd mają zostać pobrane. Pozostaw domyślne wartości i przejdź dalej. 



 

18. Kolejny krok przedstawia tzw. Connection String, czyli informację w jaki sposób aplikacja będzie 
łączyła się do bazy. Przejdź dalej. 

19. W następnym kroku możesz opcjonalnie dodać do aplikacji certyfikat. Kliknij Next > i w ostatnim 
kroku Publish. 

20. Teraz przeniesiemy pliki instalacyjne na maszynę lokalną. W tym celu, w narzędziu wirtualizacji 
VirtualBox, z menu Ustawienia wybierz Współdzielone katalogi…. 

 

Dodaj katalog znajdujący się na Twoim komputerze lokalnym. 

 

  



21. Na maszynie wirtualnej otwórz My Computer i z menu Tools wybierz Map Network Drive…. 

 

Kliknij na przycisk Browse… i wybierz VirtualBox Shared Folders -> \\Vboxsvr -> 
\\VBOXSVR\Instalator. Zatwierdź przyciskiem OK i kliknij Finish. Teraz możesz wymieniać pliki 
pomiędzy maszyną wirtualną a lokalną poprzez wskazany katalog, który na maszynie wirtualnej 
widziany będzie jako dysk. 

22. Skopiuj katalog zawierający pliki instalacyjne z maszyny wirtualnej na lokalną i rozpocznij 
instalację na maszynie lokalnej uruchamiając plik setup.exe. Jeśli zostaniesz poproszony 
o podanie hasła administratora – poproś prowadzącego Następnie uruchom i przetestuj 
zainstalowaną aplikację. 

  



7. Kopie bezpieczeństwa i odtwarzanie 

 

Czas trwania: 25 minut 

 

W poprzednim kroku stworzyliśmy aplikację. Można sobie wyobrazić, że w rzeczywistości aplikacja ta 
mogłaby być wykorzystywana przez wielu użytkowników i przechowywać ważne dane. Dlatego też 
należy zadbać o to, aby dane te pod żadnym pozorem nie zostały utracone w przypadku awarii. 
W tym ćwiczeniu nauczymy się w jaki sposób tworzyć kopie bezpieczeństwa (backup) bazy danych 
oraz jak ją odtworzyć w przypadku, gdy coś pójdzie nie tak. 

1. Na maszynie wirtualnej, w eksploratorze obiektów programu SQL Server Management Studio, 
kliknij PPM na węźle bazy Instytut i wybierz Tasks -> Back Up. W oknie konfigiracji backup’u, 
w zakładce General, możesz wybrać typ kopii bezpieczeństwa (Backup type) – pełna (Full) lub 
różnicowa (Differential). Pełny backup powoduje zapisanie stanu wszystkich plików danych. 
Wymaga więc dużo miejsca, jednak pozwala dokładnie odtworzyć stan bazy z danej chwili. 
Backup różnicowy bazuje na ostatnim backup’ie pełnym.  Dzięki temu tworzenie kopii jest dużo 
szybsze i zajmuje mniej miejsca niż backup pełny. Jeśli jednak plik backupu pełnego zostanie 
zniszczony, wszystkie późniejsze kopie różnicowe będą bezużyteczne. Spróbuj wybrać opcję 
Differential i zatwierdzić przyciskiem OK. Jak widzisz SQL Server nie pozwoli tego zrobić, 
ponieważ nie wykonaliśmy jeszcze backup’u pełnego. Wybierz więc opcję Full. Przejdź teraz do 
sekcji Destination. Możesz utworzyć kopię bezpieczeństwa bazy w wielu lokalizacjach 
jednocześnie, zmniejszając tym samym ryzyko utracenia swoich danych. Kliknij przycisk Add… 
i dodaj C:\Disk3\Instytut.bak jako dodatkową lokalizację kopii. 

 

Przejdź teraz do zakładki Options. Na dole znajduje się sekcja Compression, w której można 
wybrać, czy pliki kopii mają być kompresowane, czy nie. Jest to opcja, którą jako administrator 
zdecydowanie należy rozważyć. Wadą kompresji jest większe obciążenie procesora podczas 
wykonywania kopii. Dodatkowo, gdy baza posiada dużo unikatowych wartości, mogą się one 
słabo kompresować. Wówczas cały „trud” procesora może być zbędny, gdyż tak naprawdę 



zyskamy niewiele miejsca. Zaletą kompresji jest jednak możliwe znaczne przyspieszenie zapisu 
kopii, gdyż dane kompresowane są przed zapisem na dysk. W ten sposób liczba operacji na dysku 
się zmniejsza, co przyspiesza cały proces. Oczywistą zaletą kompresji jest również zmniejszenie 
miejsca zajmowanego przez kopie na dysku. Wybierz opcję kompresji backupu (Compress 
backup) i zatwierdź przyciskiem OK. 

 

2. Przejdź teraz do naszej aplikacji webowej i wprowadź dowolne zmiany. Dodaj nowy zespół, 
pracowników, pozmieniaj pensje, itd…. 

3. Wróć do maszyny wirtualnej i spróbuj utworzyć kopię różnicową bez kompresji danych. Co 
zaobserwowałeś/aś? 

Włącz kompresję i wykonaj kopię różnicową. 

4. Przejdź do aplikacji webowej i dodaj kolejnego pracownika do dowolnego z zespołów. 
Spróbujemy teraz odzyskać bazę sprzed tej czynności. Wróć do maszyny wirtualnej, kliknij PPM 
na bazie Instytut i wybierz Tasks -> Restore -> Database. W zakładce General możesz wybrać 
zarówno czas, z którego baza ma zostać odzyskana (To a point in time) jak i pliki, które mają 
zostać wykorzystane. Zauważ, że nie możesz wybrać tylko pliku różnicowego – jeśli chcesz z niego 
skorzystać musisz również wykorzystać pełną kopię. 



 

Przejdź teraz do zakładki Options. Wymusimy, aby aktualna baza została nadpisana (Overwrite 
the existing database). Dodatkowo można podjąć decyzję dotyczącą odtwarzania logu bazy 
danych. Można wycofać wszystkie niezatwierdzone transakcje lub pozostawić je, co będzie 
wymagało ręcznego ich wycofania lub zatwierdzenia. Dodatkowo można wycofać 
niezatwierdzone transakcje pozostawiając sobie ewentualną furtkę powrotu do stanu sprzed 
odtwarzania. Pozostaw domyślną wartość i kliknij OK. 

 

5. Przejdź do aplikacji webowej i odśwież stronę. Zobacz, czy zmiany zostały wycofane. 

  



8. Planowanie automatycznej konserwacji 

 

Czas trwania: 25 minut 

 

W poprzednim ćwiczeniu nauczyliśmy się tworzyć kopie bezpieczeństwa i odtwarzać z nich stan bazy 
danych. Jednak w rzeczywistych zastosowaniach administrator z reguły nie wykonuje backupów 
ręcznie. Wykonują się one automatycznie w zaplanowany przez niego sposób. W tym ćwiczeniu 
nauczymy się definiować plany automatycznej konserwacji instancji. 

1. Usługą odpowiedzialną za zarządzanie zaplanowanymi zadaniami serwera jest SQL Server Agent. 
Usługa ta domyślnie jest wyłączona, dlatego najpierw musimy ją włączyć. Skonfiguruj urucha-
mianie usługi SQL Server Agent, aby uruchamiała się automatycznie przy starcie systemu, w 
analogiczny sposób jak skonfigurowałeś/aś usługę SQL Server Browser w punkcie 2 ćwiczenia 6. 

 

Usługa SQL Server Agent korzysta z systemowej bazy msdb. Planując automatyczne zadania 
należy więc bezwzględnie zaplanować backup tej bazy. 

2. Niektórymi z ważniejszych zadań administratora produkcyjnej bazy danych są: 

 tworzenie kopii bezpieczeństwa danych oraz logów, 

 sprawdzanie integralności danych, 

 porządkowanie danych w celu zwolnienia miejsca, 

 przebudowywanie indeksów, 

 zbieranie statystyk. 

Postaramy się zdefiniować plan konserwacji, który będzie wykonywał te czynności za nas. 

3. Przejdź do katalogu Management w eksploratorze obiektów, kliknij PPM na folderze 
Maintenance Plans  i wybierz Meintenance Plan Wizard. Pojawi się okno informacyjne kreatora 
planów konserwacji. Kliknij Next aby przejść dalej. 



 

W kolejnym kroku możesz podać nazwę oraz opis dla swojego planu. Jako nazwę podaj 
PlanTygodniowyInstytut. 

 

Dodatkowo masz możliwość wyboru, czy każde zadanie z planu ma być zaplanowane w osobnym 
terminie lub czy wszystkie zadania mają zostać wykonane w jednym terminie bądź tylko na 
żądanie. Wybierz drugą opcję i kliknij przycisk Change…, aby zdefiniować termin realizacji zadań. 
Pole Schedule type pozwala wybrać rodzaj terminu. Można zaplanować, aby plan uruchamiał się 
za każdym razem, gdy uruchomiona zostanie usługa SQL Server Agent lub gdy procesor przejdzie 
w stan bezczynności. Można również zaplanować zadanie tylko na jedno wykonanie lub tak, aby 
powtarzało się cyklicznie. Wybierz opcję cyklicznego powtarzania planu (Recurring), a następnie 
przyjrzyj się możliwościom definiowania terminów. Pozostaw wartości domyślne i kliknij OK. 



 

W kolejnym kroku możesz wybrać jakie zadania mają zostać wykonane w ramach planu. Wybierz 
zadania, które wymieniliśmy w punkcie 2: 

 Backup Database (Full) 

 Check Database Integrity 

 Shrink Database 

 Rebuild Index 

 Update Statistics 

 

W następnym kroku masz możliwość ustalenia kolejności wykonywania operacji. Pozostaw 
domyślną kolejność i przejdź do kolejnego kroku. 

Rozpocznie się teraz proces uszczegółowiania każdego z zaplanowanych zadań. Najpierw wybierz 
bazę, dla której mają zostać sprawdzone ograniczenia integralnościowe. Wszystkie zadania w tym 
planie chcemy przeprowadzać na bazie Instytut, więc wybieraj ją w każdym kolejnym kroku. 



 

W kolejnym kroku możesz podać próg rozmiaru bazy, po przekroczeniu którego uruchamiany 
będzie proces „kurczenia” bazy, czyli przesuwania wskaźnika wysokiej wody1 do rzeczywistego 
poziomu danych. Można również zdefiniować jaka część miejsca ma pozostać zarezerwowana po 
wyczyszczeniu i czy wyczyszczone miejsce ma pozostać w pliku, czy ma być oddane systemowi 
operacyjnemu. Pozostaw wartości domyślne i przejdź dalej. 

 

W dwóch kolejnych widokach (przebudowywanie indeksów oraz aktualizacja statystyk) pozostaw 
wartości domyśle, wskazując jedynie bazę Instytut. 

W kroku dotyczącym kopii zapasowej zmień lokalizację pliku kopii na C:\Disk3 i włącz kompresję. 

                                                           
1
 wskaźnik wysokiej wody - wskaźnik na ostatni blok dyskowy zaalokowany przez tabelę, który był w przeszłości lub 

obecnie wykorzystywany do przechowywania rekordów; podczas operacji na tabeli wskaźnik wysokiej wody przesuwa się tylko 

w jednym kierunku. 



 

W ostatnim kroku możesz wybrać lokalizację, w której ma zostać zapisany raport wykonania 
zadań. Dodatkowo możesz automatycznie przesłać raport pod wybrany adres email. Pozostaw 
wartości domyślne i przejdź dalej. 

 

Ostatni krok zawiera podsumowanie całego procesu tworzenia planu konserwacji. Kliknij Finish 
aby zakończyć działanie kreatora. W katalogu Maintenence Plans pojawi się nowy plan. Kliknij na 
nim dwukrotnie, aby obejrzeć wygenerowany diagram. 



 

4. Dodaj teraz kolejny plan, którego zadaniem będzie wykonywanie backupów różnicowych dla bazy 
Instytut codziennie o północy, z wyjątkiem niedzieli. Nazwij go PlanDziennyInstytut. Ustaw 
odpowiednie parametry, zgodnie z ustawieniami dla backupu pełnego. 

5. Poza zautomatyzowaniem konserwacji można również zaplanować automatyczne wykonywanie 
innych czynności. Przejdź do katalogu SQL Server Agent i rozwiń folder Jobs. Jak widzisz znajdują 
się tutaj zadania zdefiniowane w ramach planów konserwacji i można tutaj dodać własne 
zadania. 

6. Przejdź teraz do katalogu Operators, kliknij PPM i wybierz New Operator. Nadaj mu swoje imię 
w polu Name. Operatorzy to grupa osób, która może być informowana o wydarzeniach 
zachodzących w instancji, jak na przykład niepoprawne zakończenie realizacji planu konserwacji. 
Mogą być oni informowani na przykład przez pocztę elektroniczną. Możesz wprowadzić teraz 
swój adres w polu E-mail name. Kliknij OK aby utworzyć operatora. 

 

7. Kolejnym elementem ułatwiającym administrację są alarmy. Kliknij PPM na katalogu Alerts 
i wybierz New Alert. Dodamy alarm, który poinformuje utworzonego w poprzednim kroku 
operatora w momencie, w którym baza danych Instytut przekroczy 100 MB. Nazwij alarm 
AlarmPelnyInstytut (pole Name) a jako typ wybierz SQL Server Performance Condition Alert. W 
polu Object wybierz SQLServer:Databases a jako obserwowany parameter (Counter) wybierz 
Data File(s) Size (KB). W polu Instance podaj bazę Instytut i zaznacz, że alarm ma zostać 
wywołany, gdy przekroczony zostanie próg (rises above) 100 MB. 



 

Przejdź do zakładki Response, aby ustalić akcję, która ma zostać wykonana, gdy zajdzie zdarzenie. 
Jak widzisz możesz wybrać tutaj wykonanie zadania oraz poinformowanie operatora. Zaznacz 
opcję poinformowania operatora i wybierz osobę utworzoną przez Ciebie, a następnie zaznacz, że 
ma ona zostać poinformowana wiadomością e-mail. Następnie zatwierdź proces klikając OK. 

  



9. Profiler oraz Tuning Advisor 

 

Czas trwania: 15 minut 

 

W ostatnim ćwiczeniu pokażemy w jaki sposób można monitorować wykorzystanie bazy danych oraz 
jak, wykorzystując narzędzie Tuning Advisor, uzyskać na tej podstawie podpowiedzi dotyczące 
optymalizacji. 

1. Zanim zajmiemy się przeglądaniem aktywności w konkretnej bazie danych podejrzymy najpierw 
aktywność w instancji wykorzystując narzędzie Activity Monitor. Kliknij PPM na węźle instancji 
w eksploratorze obiektów i wybierz Activity Monitor. Zapoznaj się z rodzajami informacji 
udostępnianymi przez narzędzie. Przejdź do aplikacji webowej i wykonaj w niej jakąkolwiek 
czynność wymagającą komunikacji z bazą, a następnie wróć do narzędzia Activity Monitor 
i zaobserwuj zmiany wynikające z Twojego działania. 

 

2. Teraz włączymy opcję nagrywania wszystkich aktywności w bazie. Jest to zadanie dosyć 
obciążające dla serwera, dlatego też zaleca się przeprowadzanie takiego testu we w miarę  
kontrolowanych warunkach. Z menu Tools wybierz opcję SQL Server Profiler. Połącz się 
z domyślnymi danymi uwierzytelniającymi. Pojawi się ekran definiowania ustawień śladu, który 
ma zostać zapisany. Jako nazwę (Trace name) podaj Test, a wynik działania profilera zapisz do 
tabeli (Save to table) Test w bazie Baza1. 

 

Następnie przejdź do zakładki Events Selection. 



 

W zakładce Events Selection możesz wybrać zdarzenia, które mają być rejestrowane przez 
profiler. Aby zobaczyć listę wszystkich możliwych zdarzeń zaznacz pole Show all events. 

 

Pozostaw wszystkie wartości zaznaczone domyślnie i kliknij Run. 

3. Uruchom aplikację webową i wykonaj w niej kilka czynności. Możesz podejrzeć w profilerze jakie 
informacje są wówczas zapisywane. 



 

Naciśnij przycisk stop, aby zakończyć działanie profilera i zamknij narzędzie. Odśwież węzeł bazy 
Baza1 i zobaczysz w  niej nową tabelę Test. 

4. Ostatnim krokiem jest uruchomienie narzędzia Tuning Advisor. Wybierz Tools -> Database 
Engine Tuning Advisor. W polu Workload wskaż tabelę, do której zapisałeś/aś ślad. 

 

Jako bazę do analizy wybierz Instytut (pole Select databases and tables to tune) i przejdź do 
kolejnej zakładki. 



 

W zakładce Tuning Options wybierz Advanced, zaznacz pole Define max. Space for 
recommendations i wprowadź w pole tekstowe obok wartość 5. Wartość ta oznacza ile miejsca 
chcemy przeznaczyć na rekomentacje. Gdyby tego miejsca zabrakło proces zakończyłby się 
błędem. 

 

Aby rozpocząć działanie narzędzia kliknij przycisk Start Analysis. Po zakończeniu działania, 
w zakładce Recommendations możesz obejrzeć zalecenia dotyczące poszczególnych tabel. 
W naszym przypadku jednak najprawdopodobniej takich zaleceń nie będzie, ponieważ nasze 
tabele zawierają bardzo mało danych. 

  



Zadanie 
 

1. Stwórz nową bazę danych o nazwie Przychodnia. W nowo utworzonej bazie dodaj tabele oraz 
ograniczenia integralnościowe odpowiadające poniższemu schematowi. 
 

PORADNIE

PK PO_ID

 PO_NAZWA

LEKARZE

PK LE_ID

 LE_IMIE
 LE_NAZWISKO
 LE_PENSJA
FK1 LE_PO_ID

PACJENCI

PK PA_ID

 PA_IMIE
 PA_NAZWISKO

WIZYTY

PK WI_DATA
PK,FK1 WI_PO_ID
PK,FK2 WI_PA_ID
PK,FK3 WI_LE_ID

 WI_TYP
 

 
2. Stwórz anonimowy skrypt lub procedurę składowaną wypełniającą każdą z tabel losowymi 

danymi. Do tworzenia skryptów wykonywalnych dla systemu SQL Server służy język T-SQL. Język 
ten jest podobny do języka PL/SQL używanego do programowania w bazach danych firmy Oracle. 
Poniższy fragment T-SQL’a tłumaczy jak zaimplementować prostą pętlę.  
 

 
 
 
 
 
 
 
 
Zmodyfikuj poniższy kod tak aby w pętli wstawiał krotki do tabeli. 
 

3. Analogicznie jak w ćwiczeniu 9. Profiler i Tuning Advisor ustaw podsłuchiwanie operacji 
wykonywanych na bazie danych, ale przechwycone dane zapisuj do pliku a nie do tabeli. 

4. Poproś sąsiada, aby wykonał na Twojej bazie kilka złożonych zapytań (najlepiej wykorzystujących 
klauzulę JOIN). Nie podglądaj treści wpisywanych przez sąsiada zapytań! Gdy zapytania zostaną 
zadane, wyłącz Profilera. Otwórz plik z przechwyconymi zapytaniami i sprawdź na ile dokładnie 
przechwycone zapytania pokrywają się to z tym co wpisał sąsiad. 

5. Użyj narzędzia Tuning Advisor do sprawdzenia czy można zoptymalizować struktury bazodanowe. 

declare @counter int 

set @counter = 0 

while @counter < 10 

begin 

  set @counter = @counter + 1 

  print 'The counter is ' + cast(@counter as char) 

end 


